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COMPETENTIELIJST 
 
In het lab wordt een lijst bijgehouden van mensen die zelfstandig met de machine 
mogen werken.  
 
Om op die lijst te komen, begin je met deze tutorial te volgen.  
 
Indien de laboverantwoordelijke na de workshop  oordeelt dat hij vertrouwen heeft in 
je vaardigheden met de machine, plaatst hij je naam op de lijst. Hij kan ook beslissen 
daarmee te wachten tot je enkele stukken gemaakt hebt onder toezicht. 
 
Als je op de lijst staat mag je zelfstandig met de machine werken.  
Het blijft uiteraard een goed idee om voor je begint iemand anders je stuk eens te laten 
nakijken, zeker wanneer het een tijd geleden is dat je de machine gebruikt hebt. 

 
 

 

 

 

 
 
 
 
Ter info: een 
nieuwe lens kost 
300 euro. 
 
Behandel de 
machine met zorg. 

WAT MAG JE NIET SNIJDEN 
Het lab heeft een aantal materialen op voorraad. Je kan ook zelf materialen 
meebrengen om te snijden, maar niet alles mag/kan in de laser 
 
GEBRUIK GEEN: 
 
-PVC,polyvinylchloride, de dampen zijn toxisch en beschadigen de lens 
-PC, polycarbonaat, deze transparante kunststof verbrandt  
-THERMOHARDERS, alle kunststoffen die niet smeltbaar zijn, zoals PU en bakeliet 
 
Ben je niet zeker, vraag dan eerst advies aan de laboverantwoordelijke. 
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OVER DEZE TUTORIAL 
-In de marge kom je af en toe icoontjes tegen. Deze hebben de volgende betekenissen: 

  Hier moet je een opdracht uitvoeren 

 Hier moet je er een begeleider bijhalen voor je verder gaat met de 

volgende stap 

  Hier staat een belangrijke opmerking over veilig gebruik van de 
machine 
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DE MACHINE 
 

 

Laat ons eerst eens kijken hoe de machine er binnenin uitziet. 

Open de kap van de machine.   

 

Je ziet een snijkop, die bevestigd zit op een beweegbare brug, die over een snijtafel 

beweegt. (rechts op de foto) 

Deze snijkop is niet de laser zelf. De laserbron is een glazen buis van meer dan een meter 

lang die achterin de machine zit.  

 

De snijkop bevat een lens, en het schuine stuk bovenop de snijkop is een spiegel. Aan de 

linkerkant van de brug zie je een soortgelijke spiegel. Een derde spiegel zit linksachter in het 

frame. De laserstraal wordt zo vanaf de bron, via de spiegels, door het midden van de lens 

gestuurd. 

 

Op de spiegels zitten regelschroeven. Raak deze nooit aan; dan ontregel je de machine. 

Vermijd ook om met de snijkop ergens tegen aan te botsen. 

Onderaan op de snijkop zie je een luchtslang bevestigd. Hierdoor zal straks lucht geblazen 

worden. Door lucht uit de kop te blazen, vermijd je dat rook in de kop komt en de lens 

vuilmaakt. Indien dit niet gebeurt wordt de laser binnen de minuut onbruikbaar. 
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VERSCHILLEN TUSSEN DE 2 MACHINES 
 

We hebben in het lab 2 BRM lasers. Deze zijn even groot en grbruiken dezelfde software, 

maar: 

-één van de BRM’s heeft een krachtiger laserbuis. De ene is 180W, de andere 100W. De 

180W kan dikkere materialen snijden, maar heeft als nadeel dat de snijlijn grover is.  

Het laservermogen is aangeduid met een label aan het controlepaneel op de machine. 

Zoek dit label en verifieer jezelf met welke machine je werkt. 
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ONDERDELEN  
 

De laser heeft een aantal hulponderdelen nodig om goed te werken: 

1-AFZUIGING 
De laser snijdt door materiaal door het te verbranden. Daar gaat een hoop rook en 

geurhinder mee gepaard.  De BRM’s hebben hun eigen afzuiging, waar een aantal filters in 

ingebouwd zijn. 

Indien je deze afzuiging vergeet aan te zetten, zal het hele lab stinken en moet de machine 

schoongemaakt worden. 

 

De afzuiging is de grote grijze bak naast de laser. De aan/af-schakelaar vind je linksboven op 

het afgeschuinde deel. 

 

 
 

2- WATERKOELING 
 

De laserbron zelf wordt heel heet tijdens het gebruik en moet gekoeld worden. De BRM’s 

gebruiken waterkoeling.  

Wanneer je deze vergeet op te zetten, zal de laser niet werken. 

De aan-schakelaar is de zwarte draaiknop op het controlepaneel van de laser. 

-de luchtpomp en waterkoeling worden ingeschakeld met de zwarte draaiknop op het 

bedieningspaneel van de machine 
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3-LUCHTPOMP 
 

 
 

Zoals eerder beschreven wordt er lucht door de snijkop geblazen om de lens rookvrij te 

houden.  

Indien je deze vergeet aan te zetten, wordt de lens vuil en kan ze beschadigd worden. De 

laser zal niet meer werken en moeten schoongemaakt worden. 

De luchtpomp ziet eruit als die op de foto hierboven. Deze staat ergens achter de 

waterkoeling.  

4-DONGLE 
De BRM lasers worden bestuurd  vanaf de meegeleverde laptops. De software heet LaserCut 

5.3 en werkt met een dongle. 

Deze  zit opzij in de laptops en ziet die eruit als een USB-stick  Zie foto. 

 

Zonder dongle zal de machine niet werken, verwijder die niet. 
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 WERKT ALLES? 

Je zal nu controleren of alle onderdelen aangesloten zijn en werken. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 

 
Zet de lasersnijmachine aan met de groen ‘Power on’ knop. Je vindt die op het 

controlepaneel van de laser. 

(één van de twee machines heeft een sleutel die je eerst moet omdraaien, de andere niet) 

Het LCD-paneel moet nu oplichten. 

 

Draai dan de zwarte draaiknop om. Je moet de waterkoeling en de pomp horen 

aanslaan.Je moet de temperatuursindicatie op de waterkoeling zien oplichten. 

 

Controleer de waarde van deze temperatuursindicatie. Alles onder 35°C is ok. Indien de 

waarde hoger aangeeft, spreek je best een laboverantwoordelijke aan. 

De pomp zit op dezelfde schakelaar, en zit ergens achter de waterkoeling verstopt. 

Kijk of je de pomp vindt en raak die aan. Je zou die moeten voelen trillen. 

 

 
VEILIGHEID 

 

De rode cijfers vooraan de waterkoeling zijn een temperatuursindicatie. Als je die ooit boven 

de 35°C ziet stijgen, moet je stoppen met laseren en de machine eerst laten afkoelen. 
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De afzuiging zet je aan met de schakelaar links in beeld op de volgende foto. 

De led’s moeten oplichten, het aantal leds indiceert de zuigsterkte. 

 

Zet de afzuiging aan. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

Je kan de afzuigsterkte instellen door de pijltesknoppen allebei in te drukken tot de groene 

led gaat knipperen. Je kan dan de zuigesterkte bijregelen met de pijltjesknoppen. 

Probeer dit even uit, stel de zuigsterkte in op 3 leds. 
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Open de software. Deze vind je op de desktop van de laptops en heet LaserCut 5.3. 

 

De laptops kunnen in stand-by staan, druk dan op de opstartknop. Er is voorlopig geen login 

nodig. 

Je zou dit scherm te zien moeten krijgen: 

 

 

 

 

 
 
 
 
 
 
 
 

 

ALLES OK? 
 

Indien bovenstaande stappen niet lukken, roep een laboverantwoordelijke. Indien alles ok 

werkte, kan je gewoon verder. 

Het duurt nog even voor we gaan snijden, dus: 

-zet de afzuiging weer af 

-zet de waterkoeling en pomp weer af. 

De laser en pc laat je op staan. 
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CONTROLEPANEEL 
 

 

De BRM lasers kunnen bestanden onthouden. “Sheriff” in de foto hierboven is mijn 

voorbeeldfile. Je kan tot 20 files in het geheugen stoppen en deze selecteren. 

 

Met de pijltjes links-rechts ga je door de menu-items. Met de pijltjes op-neer verander je de 

instellingen.  

Druk ‘Esc’ 

Nu kan je met de pijltjes de laserkop positioneren. 

Verplaats de snijkop met de pijltjes naar het midden. 

Wanneer de machine opstart, weet die niet waar de snijkop staat. De snijkop moet tot in 

een hoek bewogen worden zodat de machine weet waar die zit. De meeste machines, zoals 

je printer thuis, doen dit automatisch. De BRM niet. De knop die dit doet, heet ‘Datum’. 

Telkens als de machine opstart moet je hier één keer op drukken. 

‘ 

Druk op ‘Datum’ De kop zal langzaam naar rechtsachter bewegen. 

‘Enter’ brengt je terug naar het menu als je een andere file wil selecteren. ‘Esc’ neemt je er 

opnieuw uit. 
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STEL DE BRANDPUNTSAFSTAND VAN DE LASER IN 
 

Plaats met de pijltjes de kop naar achter als die er nog niet staat.  

Zo vermijd je dat je tegen de kop botst als je er een stuk plaatmateriaal in legt.  

 

Zoek een stuk MDF van 3MM dik van minstens 10 cm x 10 cm 

Open de kap van de machine en plaats het stuk in de machine. 

Verplaats de kop tot boven het stuk. 

 

De focusafstand van de lasers (onderkant kop tot bovenkant plaat)  is 12mm. 

Bij de machines is een ovaal stukje rode plexi geleverd. Zie foto. Dit heeft de juiste dikte. 

Om scherp te stellen moet je de kop laten zakken tot bovenop het rode plaatje. 

Om dit te doen moet je de geribbelde ring bovenaan de zwarte buis van de snijkop 

losdraaien. In de foto hieronder wijs ik de ring in kwestie aan: 

 
 

Draai de ring los en stel de kop af op de correcte hoogte. Draai dan de ring weer handvast. 

 

Verwijder het rode plaatje 
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Vraag nu aan een laboverantwoordelijke om je werk na te kijken voor je verdergaat. 

 

 

 

 
 
 
 
 
 
 
 

 

SOFTWARE 
De BRM lasers worden bediend vanaf de meegeleverde laptops. De software heet LaserCut 

5.3 en werkt met een dongle. 

Verwijder de groene dongle niet! De laptops hebben lompweg maar 3 USB-poorten, dus als 

je een USB-stick wil inlezen moet je voorlopig de muis uittrekken. 

 

Ga naar de desktop (‘t Is Windows 8. Ik ben daar heel blij mee  Good Luck. ) en open 

LaserCut5.3 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

Ga naar File > Import en open de file c:\tutorial BRM lasers\Sheriff.dxf 

 

 
SOORTEN BESTANDEN 
In de software moet je in principe DXF-bestanden uit Autocad en .AI-besten uit Illustrator 

kunnen inladen. 

.AI-bestanden heb ik nog niet geprobeerd, ik raad aan om je bestand uit je tekenprogramma 

te exporteren als ‘ DXF versie 2004’. 
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Je zou bovenstaand beeld te zien moeten krijgen.  

De tekening bevat 2 lagen. Je kan voor deze lagen aparte snijeigenschappen instellen. Je zal 

de ster uitsnijden en de tekst graveren. 

Kijk rechtsboven. Je ziet daar de eigenschappen voor de zwarte en de rode laag. 
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Dubbelklik op de snijsnelheid van de zwarte laag. Je krijgt onderstaande pop-up. 

 

Voor MDF 3MM, op de 180W machine, stel  

Speed op 60 mm/s 

Power op 90% 

Corner power ook 90% 

Laat ‘Blow while laser’ staan. 

Op de 100 W machine gebruik volgende waarden: 

Speed op 30 mm/s 

Power op 90% 

Corner power ook 90% 

Corner power neem je standaard dezelfde waarde als voor Power. Je kan deze evenwel 

gebruiken om te compenseren voor het feit dat de geleiding vertraagt in de bochten. Dus 

voor iets als een tandwiel heb je waarschijnlijk betere resultaten als de de Corner power 

lager zet. Heb ik nog niet uitgeprobeerd… 

De aanbeveling van de verdeler is om de buizen slechts op 90% van hun vermogen te 

gebruiken zodat ze langer meegaan. 

Klik ‘OK’ 

 
INSTELLINGEN VOOR ANDERE MATERIALEN 
Naast de machine vind je een schriftje. In dit schriftje staan richtwaarden voor diverse 

materialen genoteerd. Je kan daar een kijkje nemen als je een ander materiaal wil snijden. 
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Klik op ‘Cut’ op de lijn van de rode laag. Selecteer ‘Engrave’ uit de dropdown. 

Je ziet straks wat het verschil is wanneer de laser je stuk uitsnijdt. 

 
 

Klik daarna op de snijsnelheid op dezelfde lijn: 

 

Stel Speed in op 240 

Laat Power op 33% 

Stel scan gap in op 0.1 mm. Dit is de afstand tussen 2 graveerlijnen. 

 GRAVEREN = ENGRAVING 

-als je de tekst zou uitsnijden, dan tekent de machine de contouren van de letter, zoals je 

die in de software ziet. 

-als je graveert ‘kleurt’ de laser de letters in. 
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OORSPRONG INSTELLEN  
 

Op je tekening zie je een blauw punt (normaalgezien rechtboven de tekening). Dit is het 

nulpunt van de tekening. Dit betekent dat dit op de machine overeenkomt met waar de kop 

van de laser staat. 

 
Je kan de locatie van dit punt wijzigen via Laser>Set laser origin. 

 

Selecteer ‘Set laser origin’ en klik dan op het midden van de ster. 

Gebruik de pijlen op de machine om de laserkop op een goed stuk van de MDF-plaat te 

zetten. De voorbeeldfile is ongeveer 50x50mm. 
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OPTIMISE 
Wanneer je je stuk nu zou uitsnijden, dan zou de machine de lijnen in een compleet 

willekeurige volgorde uitsnijden. Op zich kan dat geen kwaad, maar het duurt dan allemaal 

wat langer…. 

Ga naar het menu Tools>Unite lines. Dit optimaliseert de snijvolgorde van de lijnen in de 

tekening. 

Zoek dit item in het menu en klik erop. 
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TEST SNIJDIEPTE/SNIJSNELHEID 
 

Je hebt nu je file helemaal klaargezet om uit te snijden. 

 

 Ik wil nu echter dat je even een omweg maakt: 

Selecteer de tekening in de software en druk op delete  

(no worries, je kan straks ‘Undo’ doen) 

 

Zoek de tekentool voor rechthoeken en teken een kleine rechthoek (ongeveer 4x4cm) 

waar de voorbeeldtekening stond.  

Als je uitzoomt, zie je maten op de rand van het werkveld staan) 

 

Deze rechthoek moet in het zwart staan, en zal met dezelfde instellingen die je net koos 

gesneden worden. 

Je zal deze uitsnijden als test. 

 

Wanneer je de volgende keer in het lab komt, zal je ook éérst een testje doen voor je je 

eigen tekening uitsnijdt. Grote tekeningen kunnen een uur duren om te snijden en als op 

het eind blijkt dat de laser niet diep genoeg sneed, dan is dat balen… 

 

 

WAAROM TESTEN? 
De snelheid en sterkte om door een materiaal te snijden kan verschillen van week tot week: 

-de hoogte van de laserkop heb je manueel ingesteld. Een millimeter verschil hier maakt 

makkelijk 10% verschil in snijdiepte 

-de lens en spiegels worden vuil tijdens het gebruik. De laser snijdt tot 20% dieper als hij net 

is schoongemaakt. 

-zekerr bij hout kan er tot 50% verschil zitten tussen de verschillende leveringen: we hebben 

al MDF gehad die half zo snel sneed dan die we nu op stock hebben. 

 

Als je een hel plaat ver*****t doordat je niet voldoende diep snijdt EN je hebt geen test 

gedaan, dan ZAL ik je die plaat aanrekenen 
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BESTAND NAAR DE MACHINE ZENDEN 
Om de file naar de machine te zenden, volg de volgende stappen: 

-Klik op ‘Calculate’ (midden rechts in het softwarevenster) 

-Ga naar File>Save en sla het bestand op op de pc onder ‘Documenten’ en geef het een 

eigen naam (mijn voorbeeld heb ik ‘Sheriff’ genoemd)  

-Klik op ‘Download’ (rechtsonder) 

Je krijgt onderstaand venster. De filenames en het aantal files kunnen verschillen. 

 

 
 

Klik ‘Download Current’ 
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TEST POSITIONERING 
De file zit nu in het geheugen van de machine.  

Controleer op de display als de naam van de file overeenkomt met jouw file. 

 

De BRM-machines hebben een functie om te controleren of je tekening op je plaat past. 

 

Druk op ‘Test’ 

De laserkop loopt dan rond de contouren van de tekening. 

Ofwel komt dit nu terecht waar je je tekening op de plaat wil hebben, ofwel klopt dit niet en 

maakt   
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START 
 

Voor je op ‘Start’ drukt, doe volgende zaken: 

-Zet de afzuiging aan (knop op afzuiging) 

-Zet de luchtpomp en waterkoeling aan (zwarte draaischakelaar) 

-Controleer of de waterkoeling opstaat en niet te warm is (kijk of je de temperatuur ziet) 

-Controleer of er lucht uit de nozzle van de laserkop komt (open de kap van de machine en 

voel onder de kop) 

 
 

 

Vraag nu een laboverantwoordelijke om je werk na te kijken 

  

Als dit allemaal gebeurd is, druk op ‘Start’. 

 

De machine biept wanneer ze klaar is. 
Wacht dan best nog even om de kast te openen tot alle rook weggezogen is. 
 

Controleer of het vierkantje los gesneden is. 

Is dit het geval, dan kan je het voorbeeld doorsturen. 

Indien niet, pas de instellingen aan en probeer het vierkant opnieuw 

 

 
 

 

HET ECHTE BESTAND 
 

Ga terug naar de software.  

Druk herhaaldelijk op ctr +z (undo) tot je het voorbeeld terug hebt. 

Herhaal de vorige stappen vanaf ‘Bestand naar de machine zenden’ 
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MATERIAAL UITNEMEN & SCHOONMAKEN 
 
De machine biept wanneer ze klaar is. 
Wacht dan best nog even om de kast te openen tot alle rook weggezogen is. 
 
Neem de plaat eruit. 
 
Het restmateriaal gaat in de gesorteerde afvalbakken of bij de begonnen platen aan de 
rode lasercutter 
 
Afhankelijk van wat je snijdt, zullen er kleine stukken op de rooster blijven liggen, deze 
moeten verwijderd worden. 
 

 
 
Je kan hiervoor best één van de stofzuigers gebruiken. en/of de borstel op het bord naast de 
laser.  

 
 
 
 

 

MACHINE AFZETTEN 
 

De lasermachine zelf en de pc laten we meestal de ganse dag opstaan. 

De afzuiging en waterkoeling zet je wel af; deze maken veel lawaai en verbruiken heel wat 

stroom. 

 

DONE… 
Je bent nu klaar.  

Toon je eindresultaat aan de laboverantwoordelijke die je werk nakeek en vraag of je op de 

lijst mag. 

Hij zal dit ofwel doen, ofwel vragen dat je de volgende keer hem er nog even bijroept vóór je 

je werkstuk in gang zet op de laser. 
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BRM TUTORIAL  - TEACHER’S MANUAL 
 

STOP 1: 

-controleer of er 3MM MDF geladen is 

-controleer of de plaat vlak ligt en het een overschotje is 

-controleer of de focusafstand klopt 

 

 

STOP2: 

-controleer of alle onderdelen opstaan (afzuiging, waterkoeling) 

-controleer of ‘Test’ gebeurd is 

-Leg uit waar de brandblusser staat 

-Beklemtoon dat de gebruiker de machine niet alleen mag laten 

- beklemtoon dat ze altijd eerst een testje doen 

 

EINDE: 

-de student zou je er 2x bijgeroepen moeten hebben. Indien dit niet het geval is wijs hem 

hierop terecht. 

-indien je tevreden bent van zijn/haar werk, vul je de naam in op de lijst en zet je er je paraaf 

achter. Indien je er niet gerust in bent, doe dit niet en vraag de student dat hij/zij je er nog 

eens bij haalt als hij/zij zijn eigen werk gaat uitsnijden. 
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